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15. Techniniai duomenys

Elektros energija

Programinë áranga

Jungtys

Garsas

Audio atkûrimas

Video atkûrimas

Paveikslëliø (nuotraukø) atkûrimas

Saugojimo media

Media failø perkëlimas³

Ekranas

Pastaba

�

�

�

¹Pakraunamos baterijos gali bûti pakrautos
ribotà kartø skaièiø ir po tam tikro laiko jas
reikës pakeisti. Baterijos veikimo laikas
priklauso nuo nustatymø ir naudojimo.

²1 GB= 1 milijardas baitø, saugojimo talpa
bus maþesnë. Pilnas atminties iðnaudoji-
mas yra neámanomas, nes tam tikras jos
“kiekis” yra reikalingas grotuvui. Saugoji-
mo talpa nustatyta skaièiuojant apytiksliai
4 minutes dainai ir 128kbps MP3 kodavimà.

³Perkëlimo greitis priklauso nuo
operacinës sistemos ir programinës
árangos konfigûravimo.

Sistemos reikalavimai
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�

�

�

�

�

�

�
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�
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Elektros energijos tiekimas: 290 mAh Li-ion
polimerinë integruota pakraunama baterija

Grojimo laikas¹
Muzika (.mp3): iki 20 valandø (FullSound
iðjungtas);
iki 12 valandø (FullSound ájungtas)
Video (.mp4): iki 4 valandø
FM radijas: iki 10 valandø

Philips Songbird: Muzikos perkëlimui³ ir
programinës árangos atnaujinimui

Philips Media Conventer: video failø
konvertavimui ir perkëlimui ³

Ausinës 3.5 mm

Greitaeigis USB 2.0

Kanalø atskyrimas: >45dB

Daþnis: 80 – 18,000Hz

Iðvesties galia: 2 x 2.4 mW

Signalo ir triukðmo santykis: > 84 dB

Tinkami formatai:

MP3:
Bitø daþniai: 8 – 320 kbps ir VBR
Atrinkimo daþniai: 8, 11.025, 16, 22.050, 32,
44.1, 48 kHz

WMA (neapsaugotas):
Bitø daþniai: 5 – 320 kbps
Atrinkimo daþniai: 8, 11.025, 16, 22.050, 32,
44.1, 48 kHz

FLAC
Bitø daþniai: iki 1.1 Mbps
Atrinkimo daþniai: 48 kHz

APE
Bitø daþniai: iki 1.3 Mbps
Atrinkimo daþniai: 48 kHz

Tinkami formatai:

SMV

Palaikomi formatai:

JPEG

BMP

Vidinës atminties talpa²:

SA4VBE04 4 GB NAND Flash

SA4VBE08 8 GB NAND Flash

SA4VBE16 16 GB NAND Flash

Songbird (muzikos failø sinchronizavimas)

Media Conventer (video failø perkëlimui)

Windows Exployer (tempti ir paleisti
principu)

Spalvotas LCD, 128 x 160 pikseliø.

Windows® XP (SP3 arba naujesni) / Vista / 7

Pentium III 800MHz procesorius arba naujesnis

512MB RAM

500MB vietos kietajam diske

Interneto jungtis

Windows® Internet Explorer 6.0 arba naujesnis

CD-ROM valdiklis

USB lizdas
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Turinys

Reikalinga pagalba?

Praðome aplankyti
kur jûs turësite pilnà priëjimà prie pagalbiniø
duomenø, tokiø kaip vartotojo instrukcija,
paskutiniai programinës árangos atnaujinimai ir
atsakymai á daþnai uþduodamus klausimus.

www.philips.com/welcome
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naudojantis Philips Songbird programa ....36

14. Grotuvo pataisymas naudojantis
Philips Songbird ................................37

15. Techniniai duomenys ..........................38

Grojimo reþimas ............................................25

Garso nustatymai ..........................................25

Safe sound .............................................25

Iðsijungimo laikmatis ....................................26

Ekrano nustatymai.........................................26

Ekrano iðsijungimo laikmatis..................26

Ekrano uþsklanda ...................................26

Skaidriø perþiûra ...........................................26

Kalba .............................................................26

Kompiuterio jungties pasirinkimas ................27

Informacija ....................................................27

Árenginio formatavimas .................................27

Gamykliniai nustatymai .................................27

Disko ádiegimas.............................................27

Philips Songbird ádiegimas............................28

Muzikos failø ið kompiuterio surinkimas ...... 28

Perþiûrø katalogo nustatymas ................28

Media failø ákëlimas................................30

Turinys ið internetiniø ðaltiniø........................30

Paieðka internete ....................................30

Grojaraðèio sukûrimas Philips Songbird
programoje....................................................30

Grojaraðèio sukûrimas ...........................30

LikeMusic grojaraðèiø generavimas .......31

Iðsaugokite grojimo eilæ kaip
grojaraðtá ................................................32

Grojaraðèio grojimas ..............................33

Philips Songbird programoje esanèiø media
failø tvarkymas ..............................................33

Metaduomenø redagavimas ...................33

Albumo paveikslëlis................................33

Media failø iðtrynimas ið
bibliotekos..............................................34

Grotuvo sinchronizavimas su
Philips Songbird............................................34

Automatinio arba rankinio
sinchronizavimo pasirinkimas ................34

Automatinis sinchronizavimas................35

Rankinis sinchronizavimas .....................35

Sistemos reikalavimai....................................38

37

Jeigu jûsø grotuvas neveikia tinkamai arba á
niekà nereaguoja ekranas, tuomet galite perkrauti
grotuvà neprarandant duomenø:

Á nedidelæ skylutæ, esanèià VIBE grotuvo
pagrinde, ákiðkite tuðinuko galà ar kità plonà
daiktà ir paspauskite.

Jeigu jums nepavyksta perkrauti grotuvo, tuomet
galite sutaisyti savo grotuvà naudodamiesi Philips
Songbird programa:

Atsidarykite programà savo
kompiuteryje.

programoje,

Pasirinkite

Ið sàraðo pasirinkite .

Grotuvà prijunkite prie kompiuterio.

Sekite ekrane rodomas instrukcijas, norëdami
pabaigti taisymo procesà.

VIBE

1. Philips Songbird

2. Philips Songbird

Tools > Repair my Philips
Device;

VIBE

3.

Ásitikinkite, kad sekëte ekrane rodomomis
instrukcijomis, kurios nurodë, kaip reikia
grotuvà prijungti prie kompiuterio.

4.

Kaip perkrauti VIBE?

Nuspaudæ laikykite, kol grotuvas iðsijungs.

�

�

�

�

Patarimas

� Po grotuvo taisymo
programa yra iðtrinama ið grotuvo.
Grotuve lieka daugiau laisvos atminties.

Philips Songbird

14. Grotuvo pataisymas naudojantis Philips Songbird
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VIBE

VIBE

Philips Songbird

1.

2. VIBE

3. Philips
Songbird

Start > Programs >
Philips > Philips Songbird

4. VIBE Tools >
Check for updated firmware

Philips Songbird

5.

VIBE

yra valdomas vidinës programos, kuri yra
vadinama programine áranga. Po to, kai jûs
nusipirkote savo grotuvà, gamintojai iðleido
naujas programinës árangos versijas.

Programinë áranga gali nustatyti
ar yra naujø programinës árangos patobulinimø,
kuriuos galima atsisiøsti internetu.

Ásitikinkite, kad jûsø kompiuteris prijungtas prie
interneto.

Prijunkite grotuvà prie kompiuterio,
naudodamiesi USB laidu.

Savo kompiuteryje atsidarykite

Jeigu prireikia, spauskite
.

Spauskite . Tuomet pasirinkite
.

patikrina ar nëra
atnaujinimø ir ádiegia naujesnæ programinæ
árangà ið interneto, jeigu tokia yra.

Sekite ekrane rodomas instrukcijas.
Programinës árangos atsisiuntimas ir
ádiegimas pradedamas automatiðkai.
Atsisiuntus programinei árangai jûsø
grotuvas yra perkraunamas ir paruoðiamas
naudojimui.

�

�

�

�

Patarimas

Pastaba

�

�

Programinës árangos atnaujinimas
nepaveikia jûsø muzikiniø failø.

Palaukite, kol atnaujinimas bus baigtas, tik
tuomet atjunkite grotuvà nuo
kompiuterio.

VIBE

13. Programinës árangos atnaujinimas naudojantis
Philips Songbird programa

5

Pagrindinë apsauga

Atsargiai

�

�

�

�

�

�

�

�

Norëdami iðvengti þalos arba prasto
funkcionavimo:

Nepalikite grotuvo prie pernelyg didelio
karðèio, sukelto ðildymo árangos arba
tiesioginiø saulës spinduliø.

Nenumeskite savo grotuvo ir neleiskite,
kad kiti objektai uþkristø ant jo.

Neleiskite savo grotuvui panirti á vandená.
Neleiskite ausinëms ir baterijos skyriui bûti
paveiktam vandens, nes patekæs vanduo
gali sukelti didþiulæ þalà.

Ájungti mobilieji telefonai netoliese gali
sukelti trukdþius.

Atnaujinkite savo failus. Ásitikinkite, kad jûs
iðsaugote originalius, á savo árenginá
parsisiøstus failus. Philips nëra atsakingi
uþ duomenø praradimà, jeigu produktui yra
padaroma þala arba jis yra nenuskaitomas /
áskaitomas.

Valdykite (perkelkite, trinkite ir pan.)
muzikos failus tik su pateikta muzikine
programine áranga, kad iðvengtumëte
problemø.

Nenaudokite jokiø valymo priemoniø,
kuriose yra alkoholio, amoniako, benzino
arba kitø dirginanèiø medþiagø, nes jos
gali paþeisti árenginá.

Valdymo ir laikymo temperatûros

Daliø/priedø pakeitimas:

Klausymosi Saugumas

Ði naudojimosi instrukcijø knygelë yra skirta tik
informacijos perteikimui.

Jeigu iðkiltø neaiðkumø naudojantis angliðka ir
lietuviðka naudojimosi instrukcijø knygelës versija,
tuomet angliðkà versijà reikia laikyti virðesne.

Valdykite vietoje, kur temperatûra visada yra
tarp 0° ir 35 °C (nuo 32° iki 95°F).

Laikykite vietoje, kurioje temperatûra visada yra
tarp -20° ir 45°C (nuo -4° iki 113°F).

Baterijos darbo laikas gali sutrumpëti prastose
temperatûros sàlygose.

Aplankykite www.philips.com/support, norëdami
uþsakyti dalá/priedà pakeitimui.

Jeigu klausotës muzikos per ausines dideliu
garsumu, jûs galite paþeisti savo klausà. Ðis
árenginys gali groti tokiu dideliu garsumu, kuris gali
sukelti klausos sutrikimus, net jeigu toks
klausymasis truks trumpiau nei vienà minutæ.
Didelis árenginio skleidþiamas garsas reikalingas
þmonëms, kurie jau turi klausos sutrikimø.

Garsas yra klaidinantis.

Jeigu jûs klausotës muzikos dideliu garsumu, jûsø
ausys prie to pripranta. Taigi po ilgo klausymosi
jûsø ausys á didelá garsà gali reaguoti kaip á
normalø, taèiau tai vis tiek bus kenksminga jûsø
klausai. Taigi visada klausykitës tik vidutiniu
garsumu.

Nustatykite þemà garsumo lygá.

Lëtai didinkite garsumà, kol jis taps vidutinis ir gerai
girdimas.

Ilgas grotuvo klausymasis (net ir vidutiniu
garsumu), gali sukelti klausos sutrikimus.

Klausydamiesi muzikos darykite atitinkamas
pertraukas.

Klausykitës vidutiniu garsumu, darykite pertraukas.

Atsargiai reguliuokite garsumà.

Nesiklausykite tokiu garsumu, jog nebegirdite kas
aplink jus vyksta.

Pavojingose situacijose nesinaudokite grotuvu.
Neklausykite grotuvo vaþiuodami motociklu,
dviraèiu ir t.t. Jûs galite sukelti eismo trukdþius, tam
tikrose vietose grotuvo klausymasis vaþiuojant yra
uþdraustas.

�

�

�

Ilgas muzikos klausymasis pilnu garsu gali
paþeisti jûsø klausà.

Klausykitës vidutiniu garsumu.

Kaip nustatyti saugø garsumo lygá:

Klausykitës muzikos ribotà laiko tarpà:

Kai naudojatës ausinëmis, vadovaukitës toliau
nurodytomis taisyklëmis:

1. Svarbios pastabos apie saugumà



Modifikacijos

Informacija apie autorines teises

Bûkite atsakingi!
Gerbkite autorines teises.

Duomenø pasiekimas

Monkey Audio dekoderis

Atlikus gamintojo neleidþiamas modifikacijas,
vartotojas gali prarasti teisæ naudotis produktu.

Visi prekiniai þenklai ar produktø pavadinimai
priklauso atitinkamoms kompanijoms ir
organizacijoms.

Jûs paþeidþiate tarptautines sutartis ir autorines
teises, jeigu kopijuojate áraðus ið Interneto ar CD
diskø.

Kompiuteriniø programø, transliacijø, garso áraðø
kopijavimas paþeidþia autorines teises ir yra
laikomas nusikaltimu. Nenaudokite savo árenginio
tokiais tikslais.

Windows Media ir Windows logotipas yra
registruoti prekiniai þenklai, priklausantys Microsoft
korporacijai Amerikoje ir kitose ðalyse.

Philips gerbia intelektinæ nuosavybæ ir mes praðome
savo vartotojø elgtis taip pat.

Multimedia turinys, esantis Internete, gali bûti
sukurtas ir/arba platinamas be autoriniø teisiø
savininkø patvirtinimo.

Kopijavimas arba informacijos platinimas,
paþeidþiant autorines teises, gali paþeisti autoriniø
teisiø ástatymus ávairiose ðalyse, áskaitant ir jûsiðkæ.

Autoriniø teisiø ástatymø laikymasis yra jûsø
atsakomybë.

Atsisiøstø á kompiuterá video klipø áraðymas ir
perkëlimas á neðiojamàjá grotuvà yra skirtas tik
vieðiems domenams arba tinkamai licencijuotam
talpinimui. Jûs galite naudoti toká turiná savo
asmeniniam, nekomerciniam naudojimui ir turite
gerbti ámanomas autoriniø teisiø instrukcijas, kurias
pateikë darbo savininkas. Tokios instrukcijos gali
teigti, kad kopijos negali bûti daromos.

Video klipai gali turëti kopijavimo apsaugos
technologijà, kuri sustabdo tolimesná kopijavimà.
Tokiose situacijose áraðymo funkcija neveiks ir jûs
bûsite informuoti þinute.

Philips trokðta gerinti savo produktø kokybæ
uþtikrinant Philips naudotojui áspûdþius. Árenginys
iðsaugo ðiek tiek duomenø savo atmintyje apie
regionà, kuriame jûs esate. Ðie duomenys yra
naudojami problemø ir gedimø aptikimui. Iðsaugoti
duomenys gali bûti tokie: grojimo trukmë muzikos ir
radijo reþime, baterijø keitimo daþnumas ir t.t. Ðie
duomenys nenurodys ið kur jûs gavote muzikiná
turiná. Iðsaugoti duomenys bus naudojami TIK tuo
atveju, jeigu grotuvas pateks á Philips aptarnavimo
centrà ir TIK tam, kad supaprastintume klaidø
radimà ir prevencijos priemones. Patalpinta
informacija bus pasiekiama naudotojui tik jam
papraðius.

Jeigu jûs nesutinkate su ðiais nurodymais, privalote
nutraukti ðio ðaltinio kodo naudojimà ir iðtrinti já ið
savo árenginio.

1. Monkey's Audio SDK ir ðaltinio kodas gali
bûti laisvai naudojami, norint pridëti APE
formato atkûrimà, kodavimà, arba þymëjimà,
bet kokiame produkte, nemokamai arba
komerciniu bûdu. Asmeniniams tikslams
kodas gali bûti naudojamas tik gavus raðtiðkà
autoriaus leidimà.

2. Monkey's Audio ðaltinis gali bûti átrauktas á
GPL ir atviro kodo programinæ árangà, nors
paèiai Monkey's Audio negali bûti taikomi
iðoriniai licencijavimo reikalavimø ar kitø
virusiniø ðaltiniø apribojimai.

3. Kodo pakeitimai ir patobulinimai turi bûti
perduodami Monkey's Audio projektui be
jokiø apribojimø ar mokesèiø, nebent kitaip,
raðtiðku nutarimu, nustatë autorius.

4. Bet koks ðaltinio kodas, idëjos ar naudojamos
bibliotekos turi bûti patvirtintos naudojantis
programinës árangos kodu.

5. Nors programinë áranga yra pilnai patikrinta,
autorius neatsako uþ klaidas ar gedimus.

6

... Svarbios pastabos apie saugumà

Bûkite atsakingi!
Gerbkite autorines teises.
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Norëdami pasirinkti automatiná arba rankiná
sinchronizavimà,

Norëdami pasirinkti automatinio
sinchronizavimo nustatymà,

Norëdami rankiniu bûdu perkelti pasirinktus
grojaraðèius,

Norëdami rankiniu bûdu perkelti pasirinktus
media failus,

1. árenginiø (Devices)

2. rankiná (Manual) automatiná
(Auto)

3.
Apply (taikyti)

árenginiø
(Devices) Sync.

1. árenginiø (Devices)

2. Music

3.

1.

2. VIBE

1.

2. Add to Device > VIBE
VIBE

Pasirinkite grotuvà ið juostos.
Ekrane pasirodys lentelë, kurioje turësite
pasirinkti norimà sinchronizavimà.

Pasirinkite arba
sinchronizavimà.

Norëdami patvirtinti nustatymà, spauskite
.

Jeigu jûs pasirinkote automatiná
sinchronizavimà, tuomet automatinis
sinchronizavimas prasidës kai grotuvà
prijungsite prie kompiuterio;
Alternatyviai, pasirinkite grotuvà

skiltyje, tuomet spauskite

Pasirinkite grotuvà ið
juostos.

Atsiradusiame lange spauskite juostà.

Spauskite, norëdami pasirinkti nustatymà.

Pasirinkite grojaraðèius.

Nutempkite ir ákelkite grojaraðèius á
grotuvà.

Turinio juostoje deðiniu mygtuku paspauskite
ant pasirinkto media failo.

Pasirinkite .
Pasirinkti failai yra perkeliami á .

�

�

�

�

Automatinis sinchronizavimas

Rankinis sinchronizavimas

Patarimas

� Norëdami pasirinkti keletà failø vienu metu,
pasirinkimo metu nuspaudæ laikykite
mygtukà.

Ctrl

... Sinchronizavimas su kompiuterio media biblioteka
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�

�

Philips Songbird Tools
> Get Artwork

Get Artwork

1.
Remove

2.

1. Philips Songbird

2.

Philips Songbird

Philips
Songbird

Philips Songbird

programoje pasirinkite
.

Albumo paveikslëliai yra surandami
kiekvienam bibliotekoje esanèiam
pavadinimui.

Spauskite deðiná mygtukà ant pasirinktø
pavadinimø, tuomet pasirinkite .

Albumo paveikslëliai yra surandami
visiems pasirinktiems pavadinimams.

Deðiniu mygtuku spauskite ant media failo.
Pasirinkite (liet. iðimti).

Patvirtinkite.
Pasirinktas failas yra iðtrinamas ið
bibliotekos ir visø grojaraðèiø. (Iðankstinis
nustatymas yra tik “paðalinti” failà, o ne
visiðkai já “iðtrinti”. Failas vis dar egzistuos
originalioje vietoje kompiuteryje ar
kompiuteriø tinkle.)

Kompiuteryje atidarykite
programà.

Prijunkite grotuvà prie kompiuterio,
naudodamiesi USB laidu.

programoje grotuvas bus
rodomas tuomet, kai kompiuteris já
atpaþins.

Kai pirmà kartà savo grotuvà prijungsite prie
programos, pasirinkite automatiná

sinchronizavimà. Grotuvas su
programa susinchronizuojamas automatiðkai.

Jeigu nepasirinkote automatinio sinchronizavimo,
tuomet reikës atlikti rankiná sinchronizavimà.

�

�

�

�

Iðimkite media failus ið savo bibliotekos

Automatinio arba rankinio
sinchronizavimo pasirinkimas

Patarimas

�

�

Norëdami pasirinkti keletà failø vienu metu,
pasirinkimo metu nuspaudæ laikykite
mygtukà.

Norëdami pasirinkti ið eilës einanèius failus
nuspaudæ laikykite ygtukà, kai
atliekate pirmàjá ir paskutinájá pasirinkimus.

Ctrl

Shift m

Grotuvo sinchronizavimas su
Philips Songbird

... Sinchronizavimas su kompiuterio media biblioteka

FLAC dekoderis XPAT XML Parser

Autorinës teisës (C)
2000,2001,2002,2003,2004,2005,
2006,2007,2008,2009 Josh Coalson

Perskirstymas ir kodo bei dvejetainiø formø
naudojimas, su pakeitimais ar be jø, yra leidþiamas,
jeigu laikomasi ðiø sàlygø:

Ðaltinio kodo perskirstymas privalo bûti
pateikiamas kartu su virðuje esanèiu autoriniø
teisiø praneðimu, ðiuo sàlygø sàraðu ir
áspëjimu.

Perskirstymas dvejetainëje formoje turi bûti
pateikiamas kartu su virðuje esanèiu autoriniø
teisiø praneðimu, ðiuo sàlygø sàraðu ir
áspëjimu, kuris yra ðiuose dokumentuose
ir/arba kituose ðaltiniuose.

Xiph.org Foundation ir jo partneriø vardai,
reklamuojant ar skatinant produktus, kuriuose
yra ði programinë áranga, negali bûti naudojami
be raðtiðko leidimo.

ÐI PROGRAMINË ÁRANGA YRA PATEIKTA
AUTORINIØ TEISIØ SAVININKØ IR KÛRËJØ. ÐIAI
ÁRANGAI NËRA SUTEIKIAMOS JOKIOS
GARANTIJOS. AUTORINIØ TEISIØ SAVININKAI IR
KÛRËJAI JOKIAIS ATVEJAIS NËRA ATSAKINGI UÞ
TIESIOGINÆ, NETIESIOGINÆ, ATSITIKTINÆ,
SPECIALIÀ, TIPINÆ AR PASEKMINÆ ÞALÀ
(ÁSKAITANT, BET NEAPSIRIBOJANT PAKAITINIØ
PREKIØ AR PASLAUGØ ÁSIGIJIMÀ; NAUDOJAMOS
INFORMACIJOS AR PELNO PRARADIMÀ; AR
VERSLO SUTRIKDYMÀ), KAD IR KAIP JI BÛTØ
SUKELTA IR REMIANTIS BET KOKIA
ATSAKOMYBËS TEORIJA, NUMATYTA SUTARTYJE,
GRIEÞTA ATSAKOMYBËS FORMA AR CIVILINIØ
TEISIØ PAÞEIDIMU (ÁSKAITANT NEATSARGUMÀ
AR KITU ATVEJU), KYLANTÁ BET KOKIU BÛDU
NAUDOJANT ÐIÀ PROGRAMINÆ ÁRANGÀ, NET
JEIGU ÁSPËJAMA APIE GALIMYBÆ ATSIRASTI
TOKIAI ÞALAI.

Autorinës teisës (C) 1998, 1999, 2000 Thai Open
Source Software Center Ltd.

Visiems asmenims ásigijusiems ðios programinës
árangos kopijà ir susijusius dokumentacijos failus
(toliau “Programinë áranga”) nemokamai
suteikiamas leidimas platinti ðià Programinæ árangà
be apribojimø, áskaitant teisæ naudotis, kopijuoti,
modifikuoti, sujungti, skelbti, platinti, sub-
licencijuoti ir/arba pardavinëti ðios Programinës
árangos kopijas, jeigu yra laikomasi ðiø sàlygø:

Visose Programinës árangos kopijose turi bûti
aukðèiau nurodytas praneðimas apie autorines
teises ir ðis praneðimas apie leidimà.

ÐI PROGRAMINË ÁRANGA YRA PATEIKIAMA BE
JOKIØ GARANTIJØ, MOMENTINIØ AR
NUMANOMØ, ÁSKAITANT, BET NEAPSIRIBOJANT
TINKAMUMO PREKYBAI GARANTIJAS,
TINKAMUMÀ KONKREÈIAM TIKSLUI IR
NEPAÞEIDÞIAMUMÀ.

AUTORIAI ARBA AUTORINIØ TEISIØ SAVININKAI
JOKIAIS ATVEJAIS NËRA ATSAKINGI UÞ BET
KOKIAS PRETENZIJAS, ÞALAS AR KITAS
PRIEVOLES, ATSIRADUSIAS DËL SUTARTIES,
CIVILINËS TEISËS PAÞEIDIMØ ARBA, KITU
ATVEJU, SÀLYGOTAS PROGRAMINËS ÁRANGOS AR
JOS DALIES NAUDOJIMO.

�

�

�
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... Svarbios pastabos apie saugumà
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Produkto iðmetimas

Atsargiai

�

�

Integruotos baterijos iðëmimas paþeidþia
garantijà ir gali sugadinti produktà.

Tolimesnës baterijø iðëmimo bei produkto
iðmetimo taisyklës yra tikslingos atlikti tik
produkto gyvavimo pabaigoje.

Pastaba Europos Sàjungai

Jûsø produktas yra sukurtas ir pagamintas ið tokiø
medþiagø ir komponentø, kurie gali bûti perdirbami
arba naudojami dar kartà.

Jeigu prie savo produkto matote nubraukto
konteinerio simbolá, tai reiðkia, kad produktas
pagamintas pagal Europos Direktyvà 2002/96/EC.

Niekada neiðmeskite savo produkto kartu su kitomis
namø apyvokos ðiukðlëmis. Praðome pasidomëti
vietinëmis elektros ir elektronikos produktø
iðmetimo taisyklëmis. Jeigu teisingai atsikratysite
senu produktu, tai sumaþins neigiamà átakà gamtai
ir þmoniø sveikatai.

Jûsø produkte yra integruota pakraunama baterija,
kuri, pagal Europos Direktyvà 2006/66/EC, negali
bûti iðmetama su áprastomis namø apyvokos
ðiukðlëmis.

Kad apsaugotumëte savo produkto funkcionalumà ir
saugumà, nugabenkite savo produktà á oficialià
surinkimo vietà ar ástaigà, kur profesionalas galës
iðimti arba pakeisti jûsø baterijà kaip parodyta:

Praðome susipaþinti su vietinëmis panaudotø
baterijø surinkimo taisyklëmis. Teisingas baterijø
iðmetimas padës iðvengti potencialiai neigiamø
pasekmiø gamtai ir þmoniø sveikatai.

Ðis produktas atitinka Europos Sàjungos nustatytus
reikalavimus radijo trukdþiams.

... Svarbios pastabos apie saugumà
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Grojimo eilæ iðsaugokite kaip grojaraðtá

Pridëkite dainas prie grojimo eilës pradþios
arba pabaigos

1. Save
Playlists

2. Playlists

Queue Next;

Queue Last

1.
Play

2.

1. Library > Music Videos

2.
View Metadata

Philips Songbird

Spauskite .
Grojaraðèiuose ( ) grojimo eilë
iðsaugojama kaip grojaraðtis.

Grojaraðèiuose ( ) suteikite norimà
pavadinimà savo grojaraðèiui.

Norëdami dainas pridëti prie grojimo eilës
pradþios, deðiniu mygtuku spauskite ant
nustatymø ir pasirinkite

Norëdami dainas pridëti prie grojimo eilës
pabaigos, deðiniu mygtuku spauskite ant
nustatymø ir pasirinkite .

Norëdami groti visà grojaraðtá, deðiniu mygtuku
spauskite ant grojaraðèio ir pasirinkite .

Norëdami pradëti grojimà nuo tam tikros
dainos, du kartus paspauskite ant jos.

Norëdami pasirinkti grojimo nustatymus,
naudokitës mygtukais, esanèiais grotuvo
valdymo juostoje.

Redaguodami failo informacijà (metaduomenis arba
ID3 tag), jûs galite iðrûðiuoti media failus
automatiðkai pagal dainos pavadinimà, atlikëjà,
albumà ir kità informacijà.

Po to, kai ákeliate media failus á grotuvà, bibliotekà
narðyti galite pagal metaduomenis.

Nuëjæ á arba ,
pasirinkite media failà.

Deðiniu mygtuku paspauskite ant failo,
norëdami pasirinkti (Rodyti
metaduomenis).

Pasirodo metaduomenø lentelë, kurioje
galësite redaguoti duomenis.

Albumo paveikslëlá kartais galite atsisiøsti kartu su
muzikos failais. Su programa
galite ádëti albumo paveikslëlius dainoms.

Atlikus sinchronizacijà, su kai kuriais grotuvais,
media bibliotekoje galësite narðyti pagal albumo
paveikslëlius.

�

�

�

�

�

Grojaraðèio grojimas

Metaduomenø redagavimas

Albumo paveikslëlis

Philips Songbird programoje
esanèiø media failø tvarkymas

... Sinchronizavimas su kompiuterio media biblioteka
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Pagrindinës dainos pasirinkimas

Pasirinkite maksimalø dainø skaièiø
grojaraðtyje

Iðsaugokite LikeMusic grojaraðtá

Sukurkite grojimo eilæ

Ásitikinkite, kad pagrindinei pasirinktai dainai buvo
atlikta analizë.

Nuëjæ á , du kartus
paspauskite dainos ikonëlæ;

Alternatyviai,

Nuëjæ á , deðiniu mygtuku
paspauskite ant dainos ir pasirinkite

.
puslapyje rodomas
grojaraðtis.

Kaip parodyta, pasirinkite skaièiø ið
iððokanèio meniu.

Kaip parodyta, puslapyje
spauskite

grojaraðtis iðsaugojamas
grojaraðèiø sàraðe ( ).

Nutempkite ir ákelkite dainas arba
grojaraðèius á (grojimo eilë)
langà.

LikeMusic

Library > Music
LikeMusic

Library > Music
Run

LikeMusic with
LikeMusic
LikeMusic

LikeMusic
Save as playlist.

LikeMusic
Playlists

Play Queue

�

�

�

�

�

�

�

Iðsaugokite grojimo eilæ kaip grojaraðtá

... Sinchronizavimas su kompiuterio media biblioteka
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Kà rasite dëþëje

Pastaba

� Iliustracijos yra tik reprezentacinë
priemonë. Philips pasilieka teisæ keisti
spalvà/dizainà be perspëjimo.

Grotuve esanti programinë áranga

Grotuve esantys failai

Patikrinkite, ar gavote ðiuos daiktus:

Grotuvà

Ausines

USB laidà

Greitos pradþios gidà

Saugumo bei garantijos lapà

Ðiame grotuve yra ádiegta ði programinë áranga:

(padeda atnaujinti grotuvo
programinæ árangà bei tvarkyti jûsø kompiuterio
ir grotuvo media bibliotekà).

(padeda konvertuoti
video á tokius failø formatus, kuriuos palaiko
jûsø grotuvas; padeda juos perkelti á grotuvà).

Savo kompiuterio narðyklës adresø juostoje
áveskite www.philips.com/Songbird arba
www.philips.com/support.

Ðiame grotuve yra ðie failai:

Naudojimosi instrukcijos

Daþnai uþduodami klausimai

�

�

�

�

�

Philips Songbird

Phili s Media Conventer

Norëdami parsisiøsti Philips Songbird,

p

2. Jûsø naujasis grotuvas



Perþiûra
Valdymas

Pagrindinis meniu

1.

2. Ekranas

3.

4.

5.

6. RESET

7.

8.

�

�

�

�

�

�

�

�

�

�

�

�

�

Paspauskite ir nuspaudæ laikykite:
Ájungti/iðjungti grotuvà.

Paspauskite: Pasirinkti nustatymus arba
pradëti/laikinai sustabdyti/ sugráþti á grojimà.

Paspauskite: rodyti nustatymø meniu

Paspauskite ir nuspaudæ palaikykite:
uþrakinti/atrakinti visus mygtukus.

3.5 mm ausiniø lizdas.

Paspauskite su tuðinuko galu, kai ekranas
nereaguoja á mygtukø paspaudimus.

USB jungtis, skirta ákrovimui bei duomenø
perdavimui.

Spauskite: gráþti á prieð tai buvusá lygá.

Paspauskite ir nuspaudæ laikykite: gráþti á
pagrindiná meniu.

( uzika) Groti audio failus

Þiûrëti video failus

( uotraukos)

(FM radijas) (tik su kai kuriomis
versijomis);
Áraðyti ið FM radijo (tik
su kai kuriomis
versijomis)

(Katalogai) perþiûra

(Nustatymai) grotuvo
nustatymus

Rodyti dabartiná
( abar grojama) grojimo langà

Nustatymø sàraðe:

Grojimo lange:

Grojimo lange:

Spauskite: perðokti á buvusá/kità nustatymà.
Paspauskite ir nuspaudæ laikykite: rodyti
visus galimus nustatymus abëcëlës tvarka.

Paspauskite: padidinti/sumaþinti garsumà.
Paspauskite ir nuspaudæ laikykite: greitai
padidinti/sumaþinti garsumà.

Paspauskite: pereiti prie buvusio/tolimesnio
pasirinkimo. Paspauskite ir nuspaudæ
laikykite: paieðka grojamame faile.

Þiûrëti nuotraukas

Klausytis FM radijo

Kataloge esanèiø failø

Pasirinkti norimus

�

Menu Reþimas Veiksmas

Music

Video

Pictures

FM radio

Folder view

Settings
VIBE

Now playing

M

N

D

Narðymas pagrindiniame meniu

... Jûsø naujasis grotuvas
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1. Library > Music

2.

Add to Playlist

New
Playlist

Playlists

1. Playlists +

2.

3.

LikeMusic

LikeMusic

LikeMusic

Philips Songbird
LikeMusic

LikeMusic

Dainas pasirinkite nuëjæ á .

Jeigu norite pasirinkti keletà dainø, tuomet
rinkdamiesi jas nuspaudæ laikykite Ctrl
mygtukà.

Norëdami dainas pridëti prie grojaraðèio:

Deðiniu mygtuku spauskite ant dainø,
tuomet pasirinkite ;

Pasirinkite grojaraðtá;
Dainos yra pridedamos prie grojaraðèio.

Norëdami sukurti grojaraðtá, pasirinkite
.

Dainoms yra sukuriamas naujas
grojaraðtis.
Pasirinkite , grojaraðèiui galësite
suteikti pavadinimà.

Alternatyviai,

Sukurkite grojaraðtá. Pridëkite dainas prie
grojaraðèio.

Pasirinkite , tuomet spauskite ,
norëdami sukurti grojaraðtá.

Sukuriamas naujas grojaraðtis.

Naujà grojaraðtá galite pavadinti kaip tik
uþsigeisite.

Norëdami prie grojaraðèio pridëti dar daugiau
failø, naudokitës elementaria nutempimo ir
ákëlimo funkcija.

Su analizës pagalba jûs galësite
sugeneruoti puikø grojaraðtá pagal pasirinktà
pagrindinæ dainà.

analizuoja dainas, esanèias jûsø
bibliotekoje, pagal kiekvienos jø charakteristikas ir
sukuria ryðius tarp jø. Minëti ryðiai padeda

funkcijai sukurti grojaraðèius, kuriuose
bus puikiai tarpusavyje deranèios dainos.

Kai jûs ákeliate dainas á programos
bibliotekà, pradedama analizë. Dainos,
kurios buvo atrinktos analizës metu bus
paþymimos ikonële, o dainos, kurios nebuvo
atrinktos, iðliks pilkos spalvos.

�

�

�

�

�

�

�

�

Patarimas

� Norëdami vienu metu nutempti ir ákelti
keletà failø, pasirinkdami juos nuspaudæ
laikykite mygtukà.Ctrl

LikeMusic grojaraðèiø generavimas

... Sinchronizavimas su kompiuterio media biblioteka
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Media failø ákëlimas Paieðka internete

Grojaraðèio sukûrimas

Turinys ið internetiniø ðaltiniø

Grojaraðèio sukûrimas Philips
Songbird programoje

Pastaba

�

�

Prieð atsisiunèiant arba ásigyjant internete
prieinamas paslaugas, prisijunkite prie
savo paskyros.

Kai kurios paslaugos yra prieinamos tik
tam tikrose ðalyse.

Ákelkite media failus ið kitø katalogø

Philips Songbird

File > Import Media

Library

File > Import

Playlists

Services

1.

Services

2.

programoje,

Eikite á , norëdami
pasirinkti kompiuteryje esanèius katalogus.

Media failai yra pridedami prie
bibliotekos ( ).

Arba eikite á a playlist,
norëdami pasirinkti kompiuteryje esantá
grojaraðtá.

Media failai yra pridedami prie
grojaraðèiø ( ).

Jûs galite naudotis internetiniu turiniu ir já ásigyti.
Prieinamus internetinius ðaltinius rasite nuëjæ á

, ðaltinio pasirinkimo lange.

Pasirinkite internetinæ paslaugà:

Pasirinkite vienà ið pasirinkèiø
lange;

Alternatyviai, paieðkos laukelyje spauskite
rodyklæ á apaèià, norëdami pasirinkti
internetinæ paslaugà.

Pateksite á internetinio ðaltinio tinklapá.

Ieðkokite savo media failo.

Jeigu norite, galite naudotis paieðkos
laukeliu, kad ávestumëte raktiná paieðkos
þodá.

Naudodamiesi grojaraðèiu jûs galësite tvarkyti ir
sinchronizuoti savo dainas taip, kaip jums reikës.

Pasirinkite dainas, kurias norësite groti. Pridëkite
dainas prie grojaraðèio.

�

�

�

�

�

�

�

�

... Sinchronizavimas su kompiuterio media biblioteka
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�

�

�

�

�

�

�

�

�

Ið pagrindinio meniu galite patekti á funkcinius
meniu, spausdami narðymo mygtukus
ir .

Norëdami sugráþti prie buvusio lango,
pakartotinai spauskite ; arba, spauskite ir
nuspaudæ laikykite , norëdami sugráþti á
pagrindiná meniu.

Grojant muzikai arba klausantis radijo,

Spauskite ;

Arba, pagrindinio meniu lange, spauskite ,
tuomet pasirinkite arba

;

Grojimo lange, paspauskite ir nuspaudæ
laikykite .

Pagrindinio meniu lange spauskite ,
tuomet pasirinkite

Kai grotuvas yra ájungtas, naudokitës uþrakinimo
mygtuku, norëdami iðvengti bereikalingo mygtukø
paspaudimo.

Visi mygtukai, iðskyrus garso mygtukus,
yra uþrakinami, o ekrane rodoma
uþrakinimo ikonëlë.

Tam, kad bûtø taupoma energija, ekranas po
nustatyto laiko tarpo automatiðkai iðsijungs, jeigu

VIBE grotuvu yra nesinaudojama ir

Nustatytas pasirinkimas >
.

Spauskite bet kurá mygtukà.

Naudojantis pridëtomis ausinëmis,
funkcija leidþia jums saugiai mëgautis muzika. Kai
klausotës muzikos per ausines, jûsø ausims
daromas spaudimas yra matuojamas¹ priklausomai
nuo grotuvo charakteristikø ir naudojamø ausiniø
techniniø duomenø.

Tuomet suteikiamas garso spaudimas yra
palyginamas su áprastais garsumo lygiais². Tokiu
bûdu gali bûti rodomos skirtingø spalvø ikonëles,
nurodanèios garso spaudimo lygmená ir rizikà
paþeisti klausà.

Daugiau nei
90 decibelø dienà

85 – 90 decibelø 2 valandos
per dienà

80 – 85 decibelai 5 valandos
per dienà

saugu daugiau nei 5 va-
landos per dienà

Ásitikinkite, kad prijungëte ausines.

Muzikos grojimo ekrane spauskite .
Ekrane rodomas garso ekranas.

Rodomame garso ekrane spauskite ,
norëdami pasirinkti SafeSound nustatymus.

�

Perjungti tarp Pagrindinio meniu lango ir grojimo
lango

Pagrindiniame meniu,

[Now playing] [Last
played]

Grojimo lange,

Norëdami pasirinkti tematikà savo ekranui,

[Theme].

[Display
settings] > [Backlight timer]

Norëdami iðeiti ið energijà taupanèio reþimo

SafeSound

Garso
spaudimo lygis trukmë

1.

2.

3.

Tematikos pasirinkimas

Naudokite SafeSound

� / ,
norëdami uþrakinti arba atrakinti mygtukus.
�

�

Maksimali

30 minuèiø
per

Mygtukø uþrakinimas/atrakinimas

Ekrano ájungimas/iðjungimas

SafeSound (Saugus garsas)

Patarimas

Patarimas

�

�

�

¹Ði metodologija yra sukurta remiantis
Europos norma (50332-1/2).

²Áprasti garsumo lygiai yra nustatyti
sveikatos ir saugumo taisyklëse, kurios yra
apraðytos Europos direktyvoje
2003/10/EC.

Norëdami suþinoti daugiau informacijos
apie SafeSound nustatymus, þiûrëkite skiltá
“SafeSound”, esanèià 25 puslapyje.

Spauskite ir laikykite nuspaudæ

(Raudonas)

(Oranþinë)

(Geltona)

(Þalia)

... Jûsø naujasis grotuvas
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Grotuvo ákrovimas

Grotuvo ájungimas arba iðjungimas

Pastaba

Pastaba

�

�

�

Kai VIBE grotuvà prijungsite prie
kompiuterio, jums reikës pasirinkti:

arba .

VIBE automatiðkai pasirenka
, jeigu jûs nieko nepasirinkote.

Ákraunamos baterijos turi limituotà
ákrovimø skaièiø. Baterijos ilgaamþiðkumas
priklauso nuo naudojimo ir nustatymø.

[Charge & transfer] [Charge & Play]

[Charge&
transfer]

Automatinis budëjimo reþimas ir
iðjungimas

VIBE

> [Display
settings] > [Backlight timer]

grotuve yra integruota baterija, kuri gali bûti
ákrauta naudojantis kompiuterio USB lizdu.

Kaip parodyta, prijunkite grotuvà prie kompiuterio
naudodamiesi USB laidu.

Kai baterijos iðsekusios, rodomas iðsekusiø
baterijø langas.

Kai ákrovimas baigtas, rodomas .

Nustatykite þemesná ekrano apðvietimo
laikmaèio lygá. (Eikite á

).

Paspauskite ir nuspaudæ laikykite , kol VIBE
grotuvas ásijungia arba iðsijungia.

Grotuvas turi automatinio budëjimo reþimo ir
ásijungimo funkcijà, kuri gali taupyti baterijos
energijà.

Grotuvas iðsijungia po 10 minuèiø neveiksniame
reþime (kuomet negrojama muzika, nespaudþiami
jokie mygtukai).

Baterijos lygio parodymai

Norëdami taupyti baterijos energijà ir padidinti
grojimo laikà, VIBE atlikite ðiuos pasirinkimus:

�

�

�

�

3. Pradëkite
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Naudojantis pirmàjá kartà

Norëdami nustatyti iTunes media katalogà

Norëdami nustatyti perþiûrø katalogà

Pirmà kartà atsidarius programà
kompiuteryje, atlikite ðiuos veiksmus, norëdami
ákelti failus á :

Pasirinkite iTunes media katalogà, norëdami
ákelti egzistuojanèià iTunes bibliotekà;

Pasirinkite pagrindiná katalogà skenavimui,
tuomet ákelkite esamus media failus.

programoje pagrindinis
katalogas yra nustatomas kaip perþiûrø
katalogas.

programoje, eikite á

Pasirinkite tuomet
árankiø juostà.

Patvirtinkite savo bibliotekos vietà ir
nustatymus.

Spauskite mygtukà, kurá rasite
ðalia bibliotekos mygtuko vietos.

Programinë áranga perkelia iTunes
bibliotekà á programà.

programoje perþiûrø katalogà
galite nusistatyti taip:

programoje, eikite á

meniu pasirinkit
Tuomet pasirinkite árankiø
juostà.

(perþiûrø kataloguose)
varnelëmis paþymëkite langelius kaip nurodyta.

Spauskite , tuomet pasirinkite
pagrindiná katalogà (pvz.: D:\Songbird media),
kuris ir bus jûsø perþiûrø katalogas.

programoje media failai
yra pridedami arba iðtrinami, priklausomai
nuo pagrindinio muzikos katalogo turinio.

Philips Songbird

Philips Songbird

Philips Songbird

1. Philips Songbird Tools >
Options...

2. Media Importer, iTunes
Importer

3.

4. Import Library

Philips Songbird

Philips Songbird

1. Philips Songbird Tools >
Options.

2. Options e Media Importer.
Watch Folders

3. Watch Folders

4. Browse

Philips Songbird

�

�

�

�

�

... Sinchronizavimas su kompiuterio media biblioteka
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Su jûs galite:

Tvarkyti kompiuteryje esanèius media failus;

Sinchronizuoti media bibliotekà su
savo asmeninio kompiuterio (PC) biblioteka;

Uþregistruoti tinklapyje
www.philips.com/welcome;

Atnaujinti programinæ árangà (þiûrëkite
skiltá “Programinës árangos atnaujinimas su
Philips Songbird”, esanèià 36 puslapyje);

Pataisyti grotuvà (þiûrëkite skiltá
“Grotuvo pataisymas su Philips Songbird”,
esanèià 37 puslapyje).

Kai prijungiate prie kompiuterio pirmàjá kartà,
atsidarys langas, kuriame:

Turësite pasirinkti savo ðalies kalbà.

Turësite sekti ekrane rodomomis
instrukcijomis, norëdami pabaigti ádiegimà.

Jeigu langas automatiðkai neatsidaro:

Ásitikinkite, kad grotuve atlikote ðiuos
pasirinkimus:

Nuëjæ á pasirinkote
;

Kompiuteryje pasirinkite
(Windows XP/ Windows 2000) /
(Windows Vista/ Windows 7).

Rodoma ikonëlë.

Norëdami pradëti ádiegimà, du kartus
paspauskite ant ikonëlës.

Galimas toks pasirinkimas, kad kopijuojant failus á
katalogà, jie automatiðkai bûtø pridedami prie jûsø
bibliotekos. Rekomenduojama susikurti pagrindiná
katalogà. programoje pagrindinis
katalogas yra laikomas perþiûrø katalogu. Kiekvienà
kartà atsidarius programà, dainos
ið bus automatiðkai
pridedamos/iðtrinamos pagal jûsø pagrindiná
katalogà.

Kompiuteryje susikurkite pagrindiná katalogà, nes
jame bus iðsaugojami visi media failai, pavyzdþiui,
D:\Songbird media.

Philips Songbird

VIBE

VIBE

VIBE

VIBE

VIBE

1.

2.

1.

> [CD installer],
[Enable]

2. My Computer
Computer

Philips Songbird

3.
Philips Songbird

Philips Songbird

Philips Songbird
Philips Songbird

�

�

�

�

�

�

Philips Songbird ádiegimas pirmàjá kartà

Pagrindinio katalogo sukûrimas

�

Philips Songbird ádiegimas

Media failø ið kompiuterio
surinkimas

Pastaba

Pastaba

�

�

Norëdami atlikti ádiegimà, turësite sutikti
su licencijos taisyklëmis ir sàlygomis.

Norëdami atlikti ádiegimà, turësite sutikti
su licencijos taisyklëmis ir sàlygomis.

Perþiûrø katalogo nustatymas

12. Sinchronizavimas su kompiuterio media biblioteka

Muzikos ákëlimas á grotuvà Muzikos radimas grotuve

Muzikos radimas pagal dainos
informacijà

Muzikos radimas pagal grojaraðtá

Muzikos radimas pagal katalogà

Superscroll (greita paieðka pagal
abëcëlæ)

Muzikos failus ið kompiuterio á savo galite
perkelti ðiais bûdais:

Sinchronizuoti failus Phili s Songbird
programos pagalba (skaitykite skiltá
“Sinchronizavimas su kompiuterio media
biblioteka” 28 psl.);
Su ðia programa jûs galite eiti á internetines
muzikos parduotuves, kurti grojaraðèius
arba tvarkyti savo muzikos informacijà.

Windows Exployer pagalba jûs galite perkelti
failus tiesiog tempdami juos á reikiamà
aplankalà. Taip jûs galësite sudëlioti savo
muzikà á skirtingus aplankalus.

Prijunkite savo prie kompiuterio.

Kompiuteryje eikite á r arba tiesiog
,

Pasirinkite ir kurkite norimus
aplankalus.

Savo kompiuteryje pasirinkite norimus muzikos
failus ir tempkite juos á esanèius
aplankalus.

Arba, kompiuteryje tempkite pageidaujamus
failus á grotuvà.

grotuve jûs galite ieðkoti muzikos pagal dainos
informacijà, grojaraðèius ar failø aplankalus.
Naudodamiesi funkcija jûs galite
paprastai ir greitai ieðkoti failø pagal pirmàjà failo
pavadinimo raidæ muzikos bibliotekoje.

Pagrindiniame meniu pasirinkite , norëdami
surasti muzikà pagal metaduomenis arba ID3
“uodegëlæ”: (Visos dainos),
(Atlikëjas), (Albumai) arba
(Þanrai).

Takeliai pateikti pagal abëcëlæ

Atlikëjai pateikti pagal abëcëlæ

Kiekvieno atlikëjo dainos pateiktos pagal
abëcëlæ.

Albumai pateikti pagal abëcëlæ

Dainos rodomos pagal þanrà, pvz. rokas (rock),
populiari muzika (pop).

Pasirinkite , norëdami surasti
grojaraðtá, kurá perkëlëte ið savo kompiuterio media
bibliotekos.

Pasirinkite , tuomet suraskite muzikà pagal failo
katalogà.

Pasirinkimø, kurie yra iðrûðiuoti pagal abëcëlæ,
sàraðe funkcija leis jums narðyti
pasirinktis pagal pirmàjà pavadinimo raidæ.

VIBE

1. VIBE

2. My Compute
Computer

VIBE

3.
VIBE

VIBE

VIBE

Superscroll

[All Songs] [Artists]
[Albums] [Genres]

> [Playlists]

Superscroll

�

�

�

�

�

�

�

�

�

Failø “nutempimas” Windows Exployer
programoje,

[All songs]

[Artists]

[Albums]

[Genres]

p
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4. Muzika
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�

�

�

�

�

�

�

�

�

Spauskite ir nuspaudæ laikykite ,
norëdami pradëti funkcijos
naudojimà.

Ekrane matysite pasirinktø nustatymø
pirmàsias raides.

Muzikos grojimà galite pradëti nuo dainos arba viso
albumo ar visø tam tikro atlikëjo dainø.

Pasirinkite dainà.

Spauskite , norëdami pradëti grojimà.
Grojimas prasideda nuo pasirinktos
dainos.

Pasirinkite albumà arba atlikëjà.

Spauskite (groti).

Spauskite , kad pradëtumëte grojimà.

Spauskite , norëdami laikinai sustabdyti
grojimà arba já vël pradëti.

Norëdami patekti á prieð tai buvusá langà,
spauskite .

Grojimo langas pasikeièia po keliø
sekundþiø.
Grojimo lange galite matyti failo
informacijà ir grojimo bûklæ.

Grojimo ekrane spauskite .

Pakartotinai spauskite .

Grojimo lange spauskite ir nuspaudæ
laikykite .

Dainos grojimo metu galite pasirinkti tà paèià
kolekcijà, kurioje yra esama daina.

Grojimo lange spauskite , tuomet pasirinkite
.

Eikite á pasirinkite
arba

.
Spauskite .

Grojimas prasideda nuo pasirinkto atlikëjo,
albumo arba þanro.

Grojimo lange spauskite ir pasirinkite
.

Eikite á , pasirinkite
.

Spauskite .

Grojimo ekrane spauskite , norëdami pasirinkti
grojimo nustatymus, tokius kaip grojimo reþimas,
garso nustatymai ir iðsijungimo laikmatis (þiûrëkite
skiltá “Nustatymai”, esanèià 25 puslapyje).

Grotuve galite rasti ðiuos grojaraðèius:

Grojaraðèius, kuriuos persikëlëte ið savo
kompiuterio media bibliotekos;

Tris “greituosius” grojaraðèius (playlists-on-
the-go).

Pasirinkite dainà arba pradëkite jos grojimà.

Dainø sàraðe arba grojimo lange,

Spauskite ir pasirinkite

Pasirinkite playlist-on-the-go (greitàjá
grojaraðtá). Spauskite .

Grojama daina iðsaugoma grojaraðtyje.

Superscroll

1.

2.

1.

2. > [Play]

3.

1.
[Play mode]

2. [Play music from...], [...
this artist], [... this album] [... this
genre]

1. [Play
mode]

2. [Play music from...] [All
songs]

1.

2.

[Add to playlist].

3.

�

�

�

�

�

�

Norëdami pradëti muzikos grojimà nuo dainos,

Norëdami groti visà albumà arba visas to
paties atlikëjo dainas,

Grojimo ekrane,

Norëdami reguliuoti garsumà,

Norëdami pasirinkti muzikiná failà grojimo
ekrane,

Norëdami greitai prasukti atgal arba á prieká
pasirinktoje dainoje,

Norëdami groti dainas grotuve,

Norëdami pridëti grojamà dainà,

�

�

�

�

�

�

Muzikos grojimas

Grojaraðèiai

Groti ið tos paèios kolekcijos

Grojimo nustatymø pasirinkimas

Pridëkite dainas prie playlist-on-the-go
(greitojo grojaraðèio)

... Muzika
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Kompiuterio jungties pasirinkimas

Informacija

Árenginio formatavimas

Gamykliniai nustatymai

Disko ádiegimas

Patarimas

Patarimas

�

�

* Ásitikinkite, kad nuëjæ á ,
pasirinkote .

Po grotuvo taisymo
programa yra iðtrinama ið grotuvo (þiûrë-
kite skiltá “Grotuvo pataisymas naudojantis
Philips Songbird”, esanèià 37 puslapyje).
Grotuve lieka daugiau laisvos atminties.

> CD-ROM
[Enable]

Philips Songbird

Nuëjæ á , pasirinkite
kokia jungtimi grotuvas bus prijungtas prie
kompiuterio.

Grotuvà prijungti galite naudodamiesi USB laidu
(MSC) arba Media Transfer Protocol (MTP).

* Leidþia grotuvui veikti kaip
valdikliui.

Spauskite
valdiklá, norëdami pradëti pro-
gramos ádiegimà á kompiuterá.

Sinchronizuojant grotuvà, ði
jungtis su
pagalba leidþia apsaugotus
muzikos failus paversti
grojamais formatais.

Nuëjæ á [Information] galite suþinoti ðià informacijà
apie grotuvà:

Pilnas produkto pavadinimas.
Pilnà grotuvo pavadinimà ga-
lësite patikrinti, kai atlikinësite
programinës árangos atnaujini-
mà pagalbiniame tinklapyje.

versija. Jos versijà galësite
patikrinti, kai atlikinësite pro-
graminës árangos atnaujinimà
pagalbiniame tinklapyje.

Tinklapis, kuris jums pravers,
jeigu su jûsø grotuvu iðkils
problemø.

Laisva atmintis

Atminties dydis

Dainø uþimamas atminties
dydis

Nuotraukø uþimamas atminties
dydis

Video failø uþimamais
atminties dydis

Tinkami muzikiniø failø
formatai

Tinkami nuotraukø
(paveikslëliø) formatai

Tinkami video failø formatai

Formatuokite grotuvà. Iðtrinami visi grotuve esantys
duomenys.

Pasirinkite tuomet
pasirinkite .

Nuëjæ á , galësite gràþinti visus
grotuvo gamyklinius nustatymus. Failai, kurie buvo
áraðyti á grotuvà, neiðsitrins.

Jei nuëjæ á
pasirinkote ekrane matysite nustatymus.

Nuëjæ á pasirinkite ,
norëdami, kad grotuvas veiktø kaip

valdiklis.

Du kartus paspauskite ant valdiklio, norëdami
pradëti programos ádiegimà á kompiuterá.

[PC connection preference]

[MSC]
Philips Songbird

Philips Songbird

[MTP]
Philips Songbird

[Model:]

[Firmware
version:]

[Support site:]

[Free space:]

[Total space:]

[Songs]

[Pictures]

[Videos]

[Music]

[Pictures]

[Videos]

[Format device],
[Yes]

[Factory settings]

> [PC connection preferences]
[MSC],

[CD installer] [Enable]
Philips

Songbird

[Player information]

[Disk space]

[File type supported]

Esama programinës árangos

�

... Nustatymai
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Iðsijungimo laikmatis

Ekrano nustatymai

Skaidriø perþiûra

Kalba

Ekrano iðsijungimo laikmatis

Ekrano uþsklanda

Patarimas

� Energijos taupymo sumetimais, pasirinkite
trumpà laiko trukmæ.

Ájunkite iðsijungimo laikmatá. VIBE gali automatiðkai
iðsijungti po tam tikro laiko tarpo.

Nuëjæ á
pasirinkite vienà ið pateiktø pasirinkèiø.
Spauskite .

Po pasirinkto laiko tarpo grotuvas
automatiðkai iðsijungs.

Pasirinkite

Alternatyviu atveju, muzikos grojimo lange,
spauskite

Jûs galite matyti likusá laikà, po kurio
grotuvas iðsijungs.

Ekrano tematikos pasirinkimas.

Kai ekranas yra nenaudojamas (neatliekami jokie
veiksmai), tuomet yra laikoma, kad jis yra
neveiksnioje bûsenoje. Po nustatyto laiko tarpo,
jeigu ekranas yra neveiksnioje bûsenoje, jis bus
automatiðkai iðjungtas. Norëdami taupyti baterijà,
nustatykite trumpesná laiko tarpà, po kurio ekranas
yra iðjungiamas.

Pagrindiniame meniu pasirinkite
.

Pasirinkite laiko trukmæ.
Praëjus pasirinktam laikui, neveiksnus
ekranas bus iðjungiamas automatiðkai.

Spauskite bet koká mygtukà.

Jeigu pasirinkote ekrano uþsklandà, tuomet ji
pasirodys po nustatyto laiko tarpo, kai ekranas yra
neveiksnus.

Pagrindiniame meniu pasirinkite
.

Nuëjæ á spauskite ir
, norëdami pasirinkti nustatymà:

Rodomas tuðèias ekranas.

Rodomas skaitmeninis
laikrodis.

Rodomas grojamos arba
paskutiná kartà grotos dainos
albumo paveikslëlis.

Iðjungiamas ekranas.

Rodomos pagrindinës grotuvo
funkcijos.

Spauskite bet koká mygtukà.

Kiekvienos skaidrës rodymo laiko
pasirinkimas.

Visos skaidrës rodomos pakartotinai, jeigu
funkcija ájungta.

Visos skaidrës rodomos atsitiktine tvarka,
jeigu funkcija ájungta.

Kalbà galite pasirinkti nuëjæ á .

�

�

�

�

�

�

�

�

�

[Sleep timer] > [Set sleep timer...],

> [Sleep timer];

> [Sleep timer].

1. > [Display
settings] > [Blacklight timer]

2.

1. > [Display
settings] > [Screensaver]

2. [Screensaver],

[None]

[Digital clock]

[Album art]

[Screen off]

[Demo mode]

[Language]

�

�

�

�

�

Po to, kai iðsijungimo laikmatis yra ájungtas,

[Theme]

Norëdami nustatyti laiko trukmæ

Norëdami iðeiti ið energijà taupanèio reþimo

Norëdami pasirinkti ekrano uþsklandà

Norëdami iðjungti ekrano uþsklandà

[Time per slide]

[Repeat]

[Shuffle]

... Nustatymai
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Norëdami pridëti albumà arba atlikëjà,

Iðtrinkite grojamà dainà ið grojaraðèio

Iðtrinkite visas dainas ið grojaraðèio

Norëdami iðtrinti grojamà dainà grojimo metu,

1.

2.

[Add to playlist].

3.

1. > [Remove from
Playlist].

2.

1.

2.
[Clear playlist]

3.

[Delete]

Pasirinkite albumà arba atlikëjà.

Albumø arba atlikëjø sàraðe,

Spauskite ir pasirinkite

Pasirinkite playlist-on-the-go (greitàjá
grojaraðtá). Spauskite .

Albumas arba atlikëjas iðsaugomas
grojaraðtyje.

Grojimo ekrane spauskite

Pasirinkite playlist-on-the go (greitàjá
grojaraðtá). Spauskite .

Grojama daina iðtrinama ið pasirinkto
grojaraðèio.

Eikite á grojaraðtá.

Grojaraðèiø sàraðe spauskite ir pasirinkite
.

Spauskite .
Visos dainos iðtrinamos ið grojaraðèio.

Grojimo ekrane spauskite ir pasirinkite
.

Grojama daina iðtrinama ið grotuvo.

�

�

�

�

�

�

�

�

�

Iðtrinkite dainas ið playlist-on-the-go
(greitojo grojaraðèio)

Iðtrinkite dainas ið grotuvo

... Muzika



Eikite á , norëdami groti knygas,
kurios audio formatais yra atsisiøstos ið
www.audible.com.

Ið www.audible.com atsisiøskite ir ádiekite
programinæ árangà á savo

kompiuterá.

Su ðia programine áranga jûs galësite

Audio knygas ið www.audible.com atsisiøsti
tiesiai á savo kompiuteryje esanèià audio
knygø bibliotekà;

Perkelti audio knygas á savo grotuvà.

Prijunkite savo kompiuterá prie interneto.

Ið www.audible.com, atsisiøskite
programinæ árangà, kuri yra

skirta MP3/MP4 grotuvams.

Ádiekite programinæ árangà á savo kompiuterá:

Nustatymø lange, ið pateikto klausymosi
árenginiø sàraðo pasirinkite

.

Sekite ekrane rodomas instrukcijas,
norëdami pabaigti ádiegimà.

Prijunkite savo kompiuterá prie interneto.

Kompiuteryje atsidarykite

AudibleManager programoje spauskite
mygtukà, norëdami prisijungti

prie www.audible.com.

Pasirinkite ir atsisiøskite audio knygas:

Puslapyje www.audible.com prisijunkite prie
savo paskyros;

Audio knygas atsisiøskite arba formatu.
Atsisiøstos knygos yra automatiðkai
pridedamos prie jûsø
programos.

Ájunkite savo kompiuteryje.

Prijunkite grotuvà prie kompiuterio. Palaukite,
kol grotuvà atpaþins
programa.

programoje spauskite
.

Kai grotuvà prie prijungiate
pirmà kartà, aktyvuokite grotuvà, kai bus
praðoma.

> [Audiobooks]

AudibleManager

1.

2.
AudibleManager

3.

Philips GoGear
(pasirinkti modelá)

1.

2. AudibleManager.

3. My
Library Online

4.

AudibleManager

1. AudibleManager

2.
AudibleManager

3. AudibleManager Add to
Device

AudibleManager

�

�

�

�

�

�

�

�

Audio knygø perkëlimas á grotuvà

AudibleManager ádiegimas á kompiuterá

Audio knygø atsisiuntimas á kompiuterá

Grotuvo sinchronizavimas

16

5. Audio knygos

25

Nuëjæ á ir pasirinkite nustatymus savo grotuvui.

Spauskite , norëdami pasirinkti vienà ið
nustatymø.

Spauskite , norëdami patvirtinti.

Nuëjæ á pasirinkite muzikos grojimo
reþimus:

Perjungiama grojamos dainos kolekcija

Grojamos dainos pakartojimas.

Visø dainø kataloge pakartojimas.

Visø dainø kataloge grojimas atsitiktine
tvarka.

Jeigu ájungti abu, ir , ir
reþimai,

Visos dainos kataloge yra grojamos
pakartotinai atsitiktine tvarka.

tkuria garsinius signalus,
kurie yra prarandami
suspaudþiant muzikinius failus
(pavyzdþiui, MP3, WMA).

orimø garso nustatymø
pasirinkimas.

veikia su priderinamomis ausinëmis.
Norëdami gauti kuo tikslesnius matavimus,
naudokitës prie grotuvo pridëtomis ar sàraðe
iðvardintomis ausinëmis.

Eikite á ir pasirinkite ausines,
kurios atitinka dabar naudojamas.

Pasinaudokite nustatymu ir
“uþrakinkite” didþiausià galimà garso lygá, kurá
pasirinkote.

Ásitikinkite, jog ájungëte SafeSound (þiûrëti
“Aktyvuokite” skiltá 25 psl.).

Eikite á ir pasirinkite .

Sukurkite slaptaþodá:

Eikite á ir nustatykite norimà
garsumà.

Jei reikia, áveskite slaptaþodá.

Spauskite ir pasirinkite garso lygá.

Spauskite .

Eikite á . Kai jûsø papraðys,
áveskite ir nustatykite slaptaþodá.

Eikite á , pasirinkite .
Jûs ájungëte SafeSound funkcijà.

1.

2.

[Play mode]

[Repeat 1]:

[Repeat all]:

[On]:

[Repeat all] [Shuffle all]

[FullSound]

[Equalizer]

SafeSound

[Select earphone]

[Parental control]

Slaptaþodþio sukûrimas

1.

2. [Parental control] [On]

3.
1) Norëdami ávesti simbolius, pakartotinai

spauskite arba spauskite ir
laikykite nuspaudæ .

2) Norëdami pasirinkti ávedimo vietà,
spauskite .

3) Spauskite ir patvirtinkite.

Nustatykite didþiausià galimà garso lygá

[Volume limit]

1.

2.

3.

Slaptaþodþio pakeitimas

[Change password]

[Activate] [On]

�

�

�

[Play music from...]

[Repeat]:

[Shuffle]

Pasirinkite ausines

Apsauga nuo vaikø

Aktyvuokite

�

�

�

�

�

�

A

N

�

Grojimo reþimas

Garso nustatymai

Pastaba

� Pasirinkus funkcijà,
nustatymai yra iðjungiami.

[FullSound]
[Equalizer]

SafeSound (Saugus garsas)

11. Nustatymai



24

10. Katalogø rodymas

Eikite á , norëdami perþiûrëti ir groti media failus,
esanèius grotuvo media bibliotekoje.

muzikiniams failams, kuriuos ákëlëte
(sinchronizavote) naudodamiesi ;

video failams, kuriuos ákëlëte
(sinchronizavote) naudodamiesi ;

grojaraðèiams, kuriuos ákëlëte
(sinchronizavote) á grotuvà ir grojaraðèiams,
kuriuose sukûrëte grotuve;

audio knygoms, kurias ákëlëte
(sinchronizavote) á grotuvà naudodamiesi

programine áranga.

*FM áraðams, kuriuos padarëte ðiuo
grotuvu.

Suraskite failus pagal tai, kaip juos
surûðiavote Windows Explorer programoje,
savo kompiuteryje.

Music:
Philips Songbird

Video:
Philips Songbird

Playlists:

SERVICE:

AudibleManager

Recordings:

Norëdami rasti failus, perkeltus su Windows
Explorer,

�

Patarimas

� *Ði FM radijo áraðinëjimo funkcija yra
integruota tik á kai kurias grotuvø versijas.
Remkitës ekrane rodomu grotuvo meniu,
norëdami suþinoti, kuriomis funkcijomis
galite naudotis ir jûs.

17

Norëdami perþiûrëti á grotuvà perkeltas audio
knygas,

[Books]

[Authors]

Grojimo lange,

Grojimo metu norëdami praleisti pavadinimus
arba skyrius,

Norëdami pridëti þymeklá,

Norëdami pradëti grojimà nuo þymekliu
paþymëtos vietos,

Norëdami iðtrinti þymeklá,

AudibleManager

Refresh Device

> [Audiobooks]

1.

2.

1. > [Navigation
mode] [Titles] [Section]

2.

1.
[Bookmarks] > [Add bookmark]

2.

[Bookmarks] > [Go to bookmark]

[Bookmarks] > [Delete bookmark].

[Delete audiobook]

programoje perþiûrëkite grotuvo
duomenis.

Jeigu reikia, spauskite
(atnaujinti).

Nuëjæ á , audio knygø failus
matysite surûðiuotus pagal pavadinimà arba
autoriø.

Knygos abëcëlës tvarka yra iðrûðiuojamos
pagal knygos pavadinimà.

Knygos abëcëlës tvarka yra iðrûðiuojamos
pagal knygos autoriø.

Pasirinkite knygà.

Spauskite , norëdami pradëti grojimà.
Grojimo lange matysite knygos informacijà
ir grojimo bûklæ.

Spauskite , norëdami laikinai sustabdyti
arba sugráþti á grojimà.

Norëdami sugráþti á prieð tai buvusá langà,
spauskite .

Grojimo lange spauskite
. Pasirinkite arba .

Grojimo lange spauskite .

Audio knygose grojimo laike galite pridëti iki 10
þymekliø. Tuomet galësite pradëti grojimà nuo bet
kurios þymekliu paþymëtos grojimo vietos.

Grojimo lange spauskite ir pasirinkite
.

Pasirinkite vietà.
Pasirinktas grojimo laikas yra iðsaugomas
þymekliø sàraðe.

Grojimo lange spauskite ir pasirinkite
.

Pasirinkite vienà ið pateiktø pasirinkèiø.
Grojimas prasideda nuo pasirinktos
vietos.

Grojimo lange spauskite ir pasirinkite

Pasirinkite vienà ið pateiktø pasirinkèiø.
Pasirinktas þymeklis iðtrinamas ið
þymekliø sàraðo.

Grojimo lange spauskite ir pasirinkite
.

Pasirinkta audio knyga yra iðtrinama ið
grotuvo.

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

Audio knygø radimas grotuve

Audio knygø grojimas

Þymekliø naudojimas

Audio knygø iðtrynimas ið grotuvo

... Audio knygos
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Video ákëlimas á grotuvà

Ádiekite Philips Media Conventer á savo
kompiuterá

Naudokitës Philips Media Conventer
programa

Pastaba

Pastaba

�

�

Norëdami atlikti ádiegimà, turësite sutikti
su licencijos taisyklëmis ir sàlygomis.

Norëdami atlikti ádiegimà, turësite sutikti
su licencijos taisyklëmis ir sàlygomis.

Video á grotuvà galite ákelti dviem bûdais:

Naudodamiesi
Ðios programos pagalba Jûs galite
konvertuoti savo video á kitus failø tipus,
kurie yra palaikomi jûsø grotuvo, ir lengvai
juo persikelti á VIBE.

Windows Explorer pagalba. “Drag and drop”
(liet. tempti ir mesti) principu galësite
perkelti ávairius .smv plëtinio failus.
Taip Jûs galësite susidëlioti savo failus á
pageidaujamus aplankalus ir lengvai juos
tvarkyti.

Pirmà kartà VIBE prijungus prie kompiuterio, ekrane
automatiðkai pasirodys þinutës:

Atidariusiame lange pasirinkite savo ðalá ir
kalbà.

Sekite ekrane rodomas instrukcijas ir ádiekite
programà.

Jeigu langas automatiðkai neatsidaro:

Ásitikinkite, kad grotuve atlikote ðiuos
pasirinkimus:

Nuëjæ á , pasirinkote

Kompiuteryje pasirinkite
(Windows XP/ Windows 2000) /
(Windows Vista/ Windows 7).

Rodoma ikonëlë.

Norëdami pradëti ádiegimà, du kartus
paspauskite ant , kurá rasite

aplankale.

Savo kompiuteryje atsidarykite P
programà.

USB laidu prijunkite savo grotuvà prie
kompiuterio.

Palaukite, kol grotuvas atpaþins

�

�

�

�

Philips Media Conventer;

1.

2.

1.

> [CD installer]
[Enable];

2. My Computer
Computer

Philips Songbird

3.
PMCsetup.exe

Philips Songbird

1. hilips Media
Conventer

2.

Philips
Media Conventer.

Pirmasis programos ádegimas

�

6. Video
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Eikite á , norëdami klausytis ið
FM radijo stoèiø áraðytø radijo programø.

Nustatykite radijo stotá.

Grojimo lange pasirinkite
.

Pradedamas áraðinëjimas ið FM radijo.

Spauskite , laikinai sustabdyti ar tæsti
áraðinëjimà. Spauskite , norëdami sustabdyti.

Pasirinkite , norëdami iðsaugoti áraðà.
Áraðai yra iðsaugomi á

. (Failø pavadinimø formatas:
FMRECXXX.WAV, kur XXX yra áraðo
numeris, kuris yra sugeneruojamas
automatiðkai.)

Nuëjæ á , pasirinkite
norimà áraðà.

Spauskite , norëdami groti áraðà.

Pakartotinai spauskite .

Grojimo lange paspauskite ir nuspaudæ
laikykite .

Pasirinkite arba grokite norimà áraðà.

Áraðø sàraðe arba grojimo lange

spauskite , tada pasirinkite .
Pasirinktas áraðas yra iðtrinamas ið
grotuvo.

Eikite á ir pasirinkite
.

Prijunkite grotuvà prie kompiuterio.

Kompiuteryje eikite á arba
,

Pasirinkite ;

grotuve pasirinkite áraðus ið
.

Nutempkite ir ákelkite áraðus á bet kokià vietà
kompiuteryje.

> [FM Recording]

1.

2. [Start FM radio
recording]

3.

4. [Yes]
> [FM radio

recordings]

1. > [Recordings Library]

2.

1.

2.

[Delete]

[FM Recording] [Delete
all]

1. VIBE

2. My Computer
Computer

VIBE

VIBE
Recordings > FM

3.

�

�

�

�

�

Norëdami pasirinkti failà grojimo lange,

Norëdami grojamà áraðà greitai atsukti atgal
arba prasukti á prieká,

Norëdami iðtrinti visus áraðus grotuve,

�

�

�

�

�

�

Áraðymas ið FM radijo

FM radijo áraðø klausymas

Áraðø iðtrynimas ið grotuvo

Áraðø perkëlimas á kompiuterá

Pastaba

� Ði FM radijo áraðinëjimo funkcija yra
integruota tik á kai kurias grotuvø versijas.
Remkitës ekrane rodomu grotuvo meniu,
norëdami suþinoti, kuriomis funkcijomis
galite naudotis ir jûs.

9. Áraðinëjimas
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... FM radijas

FM radijo klausymas
1. > [Presets]

2.

[Presets]

Pagrindiniame meniu eikite á .

Spauskite , norëdami pasirinkti
iðsaugotà stotá.
Spauskite , norëdami pradëti grojimà.

Spauskite , norëdami pasirinkti kità
iðsaugotà stotá ið . Spauskite ,
norëdami pradëti grojimà.

Grojimo ekrane spauskite ,
norëdami pasirinkti iðsaugotà stotá.

Grojimo lange spauskite .

Grojimo lange spauskite .

arba

arba

arba

�

�

�

�

�

�

�

Norëdami reguliuoti garsumà,

Norëdami uþtildyti arba gràþinti radijo grojimo
garsà,

19

3. Philips Media Conventer

4. Philips
Media Conventer

1.

2.

1.

2.

[Delete video]

programoje pridëkite
video failus ið savo kompiuterio bibliotekos.

Spauskite .
Video yra pridëtas prie failø sàraðo
konvertavimui ir perkëlimui.

Norëdami iðimti video ið sàraðo, spauskite
.

Pradëkite konvertavimà ir perkëlimà
programoje:

Spauskite .

Eikite á .
Video failai yra iðrûðiuojami pagal failo
pavadinimà ir abëcëlinæ tvarkà.

Eikite á .
Video failai yra iðrûðiuojami pagal failo
katalogà kompiuteryje.

Pasirinkite video.

Spauskite , norëdami pradëti grojimà.
Video grojimas prasideda gamtovaizdþio
vaizdavimu.

Spauskite , norëdami laikinai sustabdyti
ir sugráþti á grojimà.

Pakartotinai spauskite .

Grojimo lange paspauskite ir nuspaudæ
laikykite .

Pasirinkite arba grokite video.

Grojimo lange arba video failø sàraðe,

Spauskite ir pasirinkite .
Pasirinktas video failas yra iðtrinamas ið
grotuvo.

�

�

�

�

�

�

�

�

�

�

�

�

�

�

Video radimas pagal failo pavadinimà

Video failø radimas pagal katalogà

Grojimo ekrane,

Norëdami pasirinkti video failà grojimo
ekrane,

Norëdami grojamà video greitai atsukti atgal
arba prasukti á prieká,

�

�

Video radimas grotuve

Video grojimas

Video iðtrynimas ið grotuvo

... Video
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Paveikslëliø ákëlimas á grotuvà

Paveikslëliø grotuve radimas

Paveikslëliø rodymas

Paveikslëliø iðtrynimas ið grotuvo

“Skaidriø perþiûra”

Grojimo nustatymø pasirinkimas

1. VIBE

2. My computer
Computer

VIBE

3.
VIBE

VIBE

[Backlight timer]

[Slideshow settings]

[Time per slide]

[Repeat]

[Shuffle]

1.

2.

[Delete
Picture]

Prijunkite prie kompiuterio.

Kompiuteryje pasirinkite arba
,

Pasirinkite , tuomet sukurkite failø
katalogus.

Kompiuteryje naudokite nutempimo ir ákëlimo
funkcijà, norëdami failus perkelti á failø
katalogà.

Alternatyviai, naudokite nutempimo ir
ákëlimo funkcijà, norëdami failø katalogus
perkelti ið kompiuterio á .

Eikite á .
Paveikslëliai abëcëline tvarka yra
iðrûðiuojami pagal failo pavadinimà.

Eikite á .
Paveikslëliai yra iðrûðiuojami pagal failo
katalogà taip, kaip tai yra padaryta
kompiuteryje.

Pasirinkite paveikslëlá. Spauskite ir
, norëdami paveikslëlá matyti pilname

ekrane.
Paveikslëlis rodomas horizontaliai.

Spauskite , norëdami pasirinkti
paveikslëlá.

Kai paveikslëliai yra rodomi per visà ekranà,
paspauskite , norëdami pradëti skaidriø
perþiûrà.

Paveikslëliai rodomi vienas po kito.

Grojimo lange spauskite , norëdami pasirinkti
grojimo nustatymus:

Pasirinkite reikðmæ. Po
pasirinkto laiko tarpo ekranas
automatiðkai iðsijungs.

Nuëjæ á galësite pasirinkti
skaidriø perþiûros nustatymus:

Pasirinkite laiko intervalà tarp
dviejø skaidriø.

Kataloge esantys paveikslëliai
yra grojami pakartotinai.

Kataloge esantys paveikslëliai
yra grojami atsitiktine tvarka.

Pasirinkite arba grokite paveikslëlá.

Paveikslëliø sàraðe arba grojimo lange,

Spauskite , tuomet pasirinkite
.

Paveikslëlis yra iðtrinamas ið grotuvo.

�

�

�

�

�

�

�

�

Paveikslëliø radimas pagal failo pavadinimà

Paveikslëliø radimas pagal failo katalogà

Grojimo ekrane,

�

�

�

�

�

�

�

7. Nuotraukos
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Pastaba

Patarimas

�

�

Prijunkite pateiktas ausines, kai ieðkote
radijo stoèiø. Ausinës veikia kaip antena.
Norëdami pasiekti aukðtesnæ signalo
priëmimo kokybæ, ausiniø laidà judinkite
ávairiomis kryptimis.

Persikëlus á naujà vietà (ðalá ar miestà)
automatiná stoèiø radimà pradëkite ið
naujo, norëdami pasiekti geresnæ signalo
kokybæ.

Radijo stoèiø radimas

Nustatytø stoèiø iðsaugojimas

Automatinis radijo stoèiø radimas

Norëdami pasirinkti nustatytà stotá grojimo
lange

Rankinis radijo stoèiø radimas

Norëdami iðtrinti grojamà stotá,

Norëdami iðtrinti visas stotis,

Kai pirmà kartà ásijungsite radijà, pradëkite
automatinæ radijo stoèiø paieðkà.

Pagrindiniame meniu eikite á .
Iðsaugoma iki 30 stoèiø.

Pakartotinai spauskite , norëdami
pasirinkti jau iðsaugotà stotá. Spauskite ,
norëdami pradëti grojimà.

Pakartotinai spauskite .

Naudokitës rankine paieðka, norëdami surasti tam
tikrà daþná ar stotá.

Pagrindiniame meniu eikite á
.

Grojama paskutiná kartà grota radijo stotis.

Grojimo ekrane spauskite ir nuspaudæ laikykite
.

Ið esamo daþnio jûs pereisite prie
sekanèios stoties.

Norëdami ieðkoti daþnio rankiniu bûdu,
pakartotinai spauskite .

grotuve galite iðsaugoti iki 30 radijo stoèiø.

Raskite radijo stotá.

Grojimo lange spauskite ir pasirinkite
.

Spauskite , norëdami pasirinkti
vietà. Spauskite .

Grojama stotis yra iðsaugoma pasirinktoje
vietoje.

Grojimo lange arba stoèiø sàraðe spauskite
ir pasirinkite .

Grojama stotis yra pasirenkama stoèiø
sàraðe.

Spauskite ir pasirinkite stotá.

Spauskite . Pasirinkite .
Pasirinkta stotis yra iðtrinama ið iðsaugotø
stoèiø sàraðo.

Stoèiø sàraðe spauskite
.

Pasirinkite .
Visos stotys yra iðtrinamos ið iðsaugotø
stoèiø sàraðo.

1. > [Auto tune]

2.

1. > [Manual
tune]

2.

VIBE

1.

2. [Save
to preset]

3.

1.
[Clear preset]

2.

3. [Yes]

1. > [Clear all
presets]

2. [Yes]

�

�

�

�

�

�

�

arba

arba

arba

arba

arba

arba

�

�

�

�

�

8. FM radijas
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